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Chapter 6 Tutorial Examples – WaterGEMS  
The following tutorials give step-by-step instructions on how to solve example problems using the WaterGEMS 

CONNECT Edition Update 3 computer program developed by Bentley Systems.  

Tutorial 1 – Three Pumps in Parallel  

Problem Statement 

A pump station is designed to supply water to a small linen factory.  The factory, at an elevation of 58.0 meters, draws 

from a circular, constant-area tank at a base elevation of 90.0 meters with a minimum water elevation of 99.0 meters, 

an initial water elevation of 105.5 meters, a maximum water elevation of 106.5 meters, and a diameter of 10.0 meters. 

Three main parallel pumps draw water from a source with a water surface elevation of 58.0 meters.  Two pumps are 

set aside for everyday usage, and the third is set aside for emergencies.  Each pump has a set of controls that ensure it 

will run only when the water level in the tank reaches a certain level.  Use the Hazen-Williams equation to determine 

friction losses in the system.  The network layout is given in Figure 6-1; the pump and pipe data are given in the tables 

below. 

 
 
    Figure 6-1: Schematic of Example Problem 

a) Can the pumping station support the factory’s 20 l/s demand for a 24-hour period?  

b) If there were a fire at the factory that required an additional 108 l/s of water for hours 0 through 6, would the 

system with the pump controls given in the problem statement be adequate? Supply the Extended Period 

Simulation report describing the system at each time step. 

c) How might the system be operated so that the fire flow requirement in part (b) is met? 

Pipe Information for Tutorial Problem 

Pipe 
Length 

(m) 

Diameter 

(mm) 
Material Roughness 

P-1 6 150 Cast Iron 90 

P-2 6 150 Cast Iron 90 

P-3 6 150 Cast Iron 90 

P-4 71 150 Cast Iron 90 

P-5 72 150 Cast Iron 90 

P-6 73 150 Cast Iron 90 

P-7 18 200 Cast Iron 90 
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Pump Information for Tutorial Problem 

 

 

Pump 

 
Elevation 

(m) 

 

Pump Curve  

 

Controls 
 

Flow 

(l/s) 

 

Head 

(m) 

PUMP-1 57.0 
0 

32 

63 

78.0 
58.5 

0 

On when T-1 is below 105.5 meters 

Off when T-1 is above 106.0 meters 

PUMP-2 57.0 
0 

32 

63 

78.0 
58.5 

0 

On when T-1 is below 105.2 meters 

Off when T-1 is above 106.0 meters 

PUMP-3 57.0 
0 

32 

63 

67.0 
50.3 

0 

On when T-1 is below 99.25 meters 

Off when T-1 is above 103.00 meters 

 

PART (a): Can the pumping station support the factory’s 20 l/s demand for a 24-hour period? 

Solution 

Setting up the Project 

When you start WaterGEMS, you should be prompted with the Welcome to WaterGEMS dialog. From this dialog, 

you can access Quick Start Lessons, create new projects, and open existing projects.  Select Create New 

Hydraulic Model. If you are asked to Enable Change Tracking?, select No. 

If the Welcome to WaterGEMS dialog does not appear, WaterGEMS is set to Hide Welcome Page on startup. 

To start a new project, select New from the File tab. You can change from Hide Welcome Page mode to Show 

Welcome Page mode in the Global Options dialog, which is accessible by selecting Options from the Tools 

tab. 

As always when starting a new project, the file should be saved frequently to avoid losing data or simulations.  To 

save a new project, select Save As under the File tab.  Enter your project title Tutorial 1 and at any time you 

can save your project by clicking the Save button   . 

A more descriptive project title and other general information can be entered into the Info window found under the 

File tab. 

Before starting, you should setup the general default settings for the project.  You can find the default settings in 

Options  under the Tools tab.  In the Drawing tab select Schematic from the Drawing Mode field. This 

option will allow you to define the pipe lengths and node locations without having to worry about scale and 

spatial placement on the x-y plane. 

To define the default units go to the Units tab found under the Options tab. Select SI (System International) from 

the list box in the Results Default field if it is not already selected.  You can define any of the default label units 

by clicking the unit field and selecting the desired unit from the list.  For example, to change the Angle units 

from radians to degrees, click on Radians in the unit field, then select Degrees by locating it on the dropdown 

list of available units.  

 

Laying Out the System 

Begin with the pipeline running horizontally through the center of the system. Because you selected Schematic in 

the Drawing Mode field, you do not have to layout the system exactly as shown in the problem statement. You 

can roughly sketch the schematic by following the instructions here.  You will likely have to rename many of 

the elements to match the names shown in Figure 6-1.  The steps below will describe how to do this. 

Click the Layout tab to select different components for your system.  Select Reservoir. To place the reservoir, 

simply click the left mouse button in the layout area.   

Select Pipe and place the crosshair of the cursor directly over the reservoir in your layout area.  Left-click then 

move away from the reservoir to place your first pipe.  Right-click to open a menu to select Pump, then place 



48 

 

your first pump. Right-click again to select Tank and place the tank.  Right click again to select Junction to 

place the final junction (Linen Factory).  When you placed the final junction, right-click to select Done.  

Continue by entering the remaining two pumps and four pipes in the same way as described previously.  To connect 

a pipe to an object already placed in the layout area, click the object with the cursor crosshair while in the pipe 

layout mode.  The object should turn red when it is selected.  

To exit the pipe layout mode, click the Select  button on the Layout tab. 

Except for the scale, your schematic should look roughly like Figure 6-1 in the problem statement.  If a pump is 

reversed (flowing in the wrong direction), double-click on the pump to open the Properties window; you can 

set the pumping direction in the Downstream Pipe line. 

To rename pipes to match Figure 6-1, double-click a pipe that is be renamed to open its Properties window. You 

can rename a pipe by typing the new name in the Label field.  

 

Entering the Data 

Double-click the reservoir node to open its dialog editor. Change the name to “Pond” in the Label field.  Enter 58 

m in the Elevation field. Close the dialog editor. 

Double-click the tank. Enter the given diameter for the circular section and the appropriate elevations from the 

problem statement. Disregard the inactive volume field. Be sure that Elevation is selected in the Operating 

Range Type field. Close the dialog editor. 

Double-click the bottom pump. Change the name to “PUMP-1” in the Label field.  Enter the appropriate elevation 

from the pump data table in the problem statement into the Elevation field.  Click the Pump Definition field 

and select Edit Pump Definitions to open the Pump Definitions dialog. Add a new pump definition and label it 

“Pumps 1 and 2”.  In the Head tab select Standard (3 Point).  Enter the pump curve data given for PUMP-1.  If 

you need to change the units, right-click on the Flow or Head table headings and open the Units and Formatting 

dialog to change the units.  Click Close to close Pump Definition dialog.  Now select “Pumps 1 and 2” in the 

Pump Definitions field.  Close the dialog editor. 

Repeat the above process for the other pumps.  When entering the data for PUMP-3, you will have to create a new 

pump definition titled “Pump 3” for the Pump Definitions field. 

Enter the pump controls given in the problem statement.  Click Controls on the Components tab.   

Select the Conditions tab to enter the five Tank conditions as described from the problem statement information.  

Enter each condition as New and Simple.  The Condition Type is Element; select the Tank from the layout 

screen by clicking the selection icon ; select Hydraulic Grade as the Storage Attribute; the Operator and 

Hydraulic Grade is entered based on the problem statement information.   

Select the Actions tab to enter whether the pump is on or off.  The default setting is generally with the pumps on.  

Enter the six actions (each pump either on or off) as New and Simple.  For example, to turn off PUMP-1, the 

Element is entered by clicking the selection icon  and selecting PUMP-1 from the layout screen; the Pump 

Attribute would be Pump Status; the Operator would be the default “=”; then select Off for the Pump Status.  

Select the Controls tab to enter the six controls.  The controls are all Simple and entered as If/Then statements.  

For example, click New then click the Evaluate as Simple Control box.  Each condition and action are available 

to select.  To select a condition, click the arrow down icon  next to the IF Condition field, then select Find 

Condition to open a window to select {“Tank” level > 106.00 m}.  To select an action, click the arrow down 

icon  next in the THEN Action field, then select Find Action to open a window to select {“PUMP-1” pump 

status = off}.  After you enter all six control statements, close the Controls dialog. 

Double-click the junction node.  Change the name to “Linen Factory”.  Enter 58 m in the Elevation field. Click the 

Demand Collection field to enter a demand of 20 l/s as a Fixed demand pattern as after clicking the ellipse 

button.  Close both dialog editors. 
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For the pipes, you can edit the data as you have been by clicking each element individually, and then entering in 

the appropriate data.  However, this method can be time consuming, especially as the number of pipe elements 

increase.  It is often easier to edit the data in a tabular format. 

Click the Flex Tables button   found on the Home tab.  Select Pipe Table from the available tables. 

The fields highlighted in the Pipe Table are output fields.  The fields in white are input fields and can be edited as 

you would edit data in a spreadsheet.  

Warning: If you did not rename each pipe, the pipes may not be listed in the table in numerical order, nor have the 

same labels as seen in Figure 6-1.  You may want to re-label each pipe to match what is in Figure 6-1; look at the Start 

Node and Stop Node columns on the flex table to help properly label each pipe to match Figure 6-1.  After you re-

label each pipe, you may want to sort the pipe labels in ascending order.  To do this, move the cursor to the top of the 

table and place it on the Label column.  Right-click, select Sort, and then select Sort Ascending.  The pipes should 

then be listed in numerical order. 

Enter the correct pipe lengths into the Length (User Defined) column found on the Pipe Table.  Also enter the pipe 

diameters and Hazen-Williams C value.  Close the Pipe Table. 

Note: You can customize which columns appear in the Pipe Table by clicking the Edit button  in the toolbar 

at the top of the table. Table columns can be added or removed as desired.  You can also move columns in the 

table using the double arrow icons  and .  

 

Running the Model 

To run the model, first click the Compute button  on the main toolbar.  Arrows should appear on your layout 

screen indicating the flow direction in each pipe.  If you click on any of the objects, you will see the results in 

the dialog.  You could look at the results for all similar objects by opening the Flex Tables button.  For example, 

if you want to look at flows in all the pipes, select the Pipe Table.  To examine the flow through the system over 

a 24-hour period, select the Options under the Analysis or Home tab.  Double-click the Base Calculation 

Options, then in the Time Analysis Type field select EPS.  Set the start time to 12:00:00 AM and the duration 

to 24 hours.  Adjust the Hydraulic Time Step to 0.01 hours.  Close the Calculation Options window and then 

click the Compute button. 

There are a couple of ways to determine whether your model meets the target demand: 

Scroll through the Calculation Summary and check to see if there are any disconnected node warnings.  When the 

level in Tank T-1 drops to the minimum tank elevation of 99 m (tank level of 9 m), the tank closes off, preventing any 

more water from leaving.  This closure will cause the linen factory to be disconnected from the rest of the system (that 

is, it will not get the required 20 l/s). 

     -OR- 

Close the Calculation Summary window and select the Linen Factory junction.  To create a graph of the pressure at 

this node, click the Graphs button  on the Home tab.  Create a Line-Series Graph from the New button in the 

Graphs dialog.  Select the Pressure box in the Graph Series Options window then close the options window.  You 

should see the calculated pressure at the Linen Factory and notice that it never reached zero (no water pressure). 

 

Answer 

As you will see for this problem, all the pressures at the linen factory hover around 465 kPa, and no disconnected 

nodes are detected.  If you make a graph of how full the tank is (Percent Full), you will see that the tank is never less 

than 86% full.  Therefore, the pumping station can support the factory’s 20 l/s demand for a 24-hour period. 
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PART (b): If there were a fire at the factory that required an additional flow of 108 l/s for hours 0 through 6, would 

the system with the pump controls given in the problem statement be adequate?  

Solution 

Add another demand to the Linen Factory node.  To do this, double-click the Linen Factory junction and enter into 

the Demand Collection field a second fixed demand of 108 l/s in the row below the 20 l/s demand after clicking 

the Ellipse button.  Close the dialog editor. 

Select the Options under the Home or Analysis tab, and then double-click Base Calculation Options.  You only 

need to run this model for six hours, so change 24 to 6 in the Duration (hours) field.  Close the Calculation 

Options window and click Compute to run the model. 

As you scroll through the results, you will see warning messages (yellow or red indicators instead of green) 

indicating a disconnected node at the linen factory after 3 hours.  Close the User Notifications window.  Select 

the tank and create a Line-Series Graph of the water level in the tank by selecting Level (Calculated) in the 

Graph Series Options window.  The graph indicates that the water level in the tank reaches the minimum level 

of 9 meters at about 3 hours and cannot supply water to the linen factory.  Note: When the tank is empty, water 

flowing to the linen factory with drop to zero (disconnected node) but the pumps are still on giving the appearance 

that water level in the tank goes up – this is an artifact – the water level in the tank does not truly go up. 

Answer 

If there were a fire at the factory, the existing system would NOT be able to supply water after about 3 hours. 

 

PART (c): How might the system be operated so that the fire flow requirement in Part (b) is met? 

Solution 

PUMP-3 could be manually switched on at the beginning of the fire to supply the flow necessary to fight the fire at 

the linen factory.  To do this delete the pump controls for PUMP-3.  Then PUMP-3 will be always on during the model 

simulation.   

Open the Controls window by clicking Controls on the Components tab.  Delete the two controls for Pump 3 by 

highlighting them one at a time and clicking Delete .  Close the Controls window. 

Click Compute to run the model.  As you scroll through the User Notifications window, there should not be any 

warning messages indicating a disconnected node. 

Select the tank and create a Line-Series Graph of the water level in the tank by selecting Level (Calculated) in 

the Graph Series Options window.  The graph indicates that the water level in the tank continues to decrease 

but can supply water to the linen factory for the entire 6-hour period. 

Answer 

If pump 3 is set to turn on at the start of a fire alarm in the linen factory, water can be supplied for at least 6 hours. 
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Tutorial 2 – Water Quality 

Problem Statement 

A local water company is concerned with the water quality in its distribution network.  The company wishes to 

determine the age and chlorine concentration of the water as it exits the system at different junctions.  The water 

surface at the reservoir is 70 meters. 

Chlorine is injected into the system at the source of flow, R-1, at a concentration of 1.0 mg/l.  It has been determined 

through a series of bottle tests that the average bulk reaction rate of the chlorine in the system (including all pipes and 

tanks) is approximately –0.5/day. 

The network model may be entered in WaterGEMS CONNECT Edition Update 3 using the layout in Figure 6-2 and 

the data that follows. 

 

 

    Figure 6-2: Schematic for Water Quality Tutorial 

 

The tank is circular with a diameter of 15.0 meters.  The minimum elevation is 99.0 meters.  The maximum elevation 

is 104.0 meters, and the initial elevation is 103.4 meters.  The base elevation is 98.0 meters, and the inactive volume 

is 10.0 m3.  The elevation of the pump is 69.0 meters and is initially on. 

 

Pump Information for Water Quality Tutorial 

Flow 

(l/min) 

Head 

(m) 
Controls 

0 40 
Off if node T-1 above 103.5 m 

 

On if node T-1 below 99.5 m 

3,000 35 

6,000 24 

 

 



52 

 

Continuous Demand Pattern Data for Water Quality Tutorial 

Time from 

Start (hr) 
Multiplier 

 

Time from 

Start (hr) 
Multiplier 

Start 0.80 13 1.30 

1 0.60 14 1.40 

2 0.50 15 1.50 

3 0.50 16 1.60 

4 0.55 17 1.80 

5 0.60 18 1.80 

6 0.80 19 1.40 

7 1.10 20 1.20 

8 1.50 21 1.00 

9 1.40 22 0.90 

10 1.30 23 0.80 

11 1.40 24 0.80 

12 1.40   

 

Junction Data for Water Quality Tutorial 

Junction 
Elevation 

(m) 

Demand 

(l/min) 

J-1 73 151 

J-2 67 227 

J-3 85 229 

J-4 61 212 

J-5 82 208 

J-6 56 219 

J-7 67 215 

J-8 73 219 

J-9 55 215 

 

Pipe Data for Water Quality Tutorial 

Pipe 
Length 

(m) 

Diameter 

(mm) 
Roughness 

P-1 300 200 130 

P-2 305 200 130 

P-3 225 200 130 

P-4 301 200 130 

P-5 225 200 130 

P-6 301 200 130 

P-7 225 200 130 

P-8 301 200 130 

P-9 200 200 130 
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P-10 301 200 130 

P-11 300 200 130 

P-12 1 250 130 

P-13 3,000 300 130 

P-14 300 300 130 

 

a) Perform an age analysis on the system using a duration of seven days and a time step of one hour. Determine 

the youngest and oldest water in the distribution system and the storage tank. Explain why water age varies. 

b) Perform a constituent analysis using the same duration and time step as in part (a). Determine the range of 

concentrations in the system and the storage tank. Explain the behavior of the system with regard to chlorine.  

c) Are the simulation results consistent with the known behavior of chlorine? 

d) Why is it necessary to run the model for such a long period of time? Do you feel seven days is too long or 

too short a time period to test the model? Why? 

Solution  

Use the same steps as in Tutorial 1 to setup the project, layout the system, and enter the data for the reservoir, pump, 

tank, all pipes and all junctions.  Be sure to set units to System International and the drawing mode to 

Schematic.  You will likely have to rename many of the elements after you draw the general layout to make sure 

data is correctly entered for each element.  It is easier to rename the junctions before renaming the pipes to match 

Figure 6-2.  If you need to change the units, right-click over the line heading and open the Units and Formatting 

dialog to change the units. 

The pump definition and control dialogs are found on the Components tab.  Refer to Tutorial 1 to review how to 

enter data into these windows. 

The demand pattern data can be entered by selecting Patterns on the Components tab.  Right-click Hydraulic to 

select New.  The Start Time is 12:00:00 AM, the Starting Multiplier is 0.80, and the Pattern Format is 

Continuous.  Enter the data from the problem statement table under the Hourly tab. 

The demand pattern can be assigned to a selected junction by clicking a junction and entering Hydraulic Pattern 

– 1 into the Demand Collection field, or the pattern can be assigned to all junctions as a Global Edit.  In this 

case, assign the demand pattern to all junctions by selecting Demand Control Center on the Components tab.  

Click Yes to continue.  On the Junctions tab, right-click the Pattern (Demand) table heading to select Global 

Edit.  Select Hydraulic Pattern – 1 in the Value: field.   You can also easily input the Demand (Base) values 

for each junction in this window.  Click Close and close the Demand Control Center dialog. 

Base Scenario 

Run the model for a 24-hour period by selecting the Options under the Analysis or Home tab.  Double-click the 

Base Calculation Options then in the Time Analysis Type select EPS.   The Duration (hours) is 24 hours and 

the Hydraulic Time Step (hours) is 1.0 hour.  Close the Base Calculation Options dialog.  

Click on the Scenarios icon.  Notice that the Compute button is in the Scenario window toolbar.  Click the Compute 

button.  WaterGEMS calculates the system parameters for a 24-hour simulation period.  Details of the calculation 

can be viewed on the Calculation Summary window.  Close the Calculation Summary and Scenarios 

windows. 

Click on the tank then the Graphs button  on the Home tab.  Create a Line-Series Graph from the New button 

in the Graphs dialog.  Select the Percent Full box under “Results” under the Fields field in the Graph Series 

Options window.  Close the Graph Series Options window. Size the graph window to fit on the layout screen 

such that you can see most of the layout and the toolbar in the Graph window that contains the Play      button 
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.  Play the 24-hour simulation by clicking the Play button  in the Graph window.  Pipe flows are indicated 

by the arrows.  Note that that there is no flow in pipes P-12 and P-13 when the pump is not operating. The flow 

direction reverses in pipes P-1, P-2, P-3, P-4, P-5, P-7, P-8, P-9, and P-14 over the 24-hour period. The volume 

of the water in tank T-1 is indicated by the Percent Full (%) on the y-axis of the graph. 

 

Age Analysis 

Click Options to open the Calculation Options window.  Duplicate by highlighting the Base Calculations Options 

line then clicking the Duplicate button  and a copy of Base Calculation Options will be created.  With the 

copy highlighted, click Rename  and change the copy’s name to “Age Analysis Calculation Options”. 

Double-click the age calculation options you just created and select Age in the Calculation Type field. The 

Duration is 168 hours (7 days), and the Hydraulic Time Step is 1.00 hr.  

The analysis of the age of water within the network may be performed by defining and running an age analysis 

scenario. From the Analysis or Home tab, select Scenarios. 

Create a new Base Scenario by clicking the New button.  Enter “Age Analysis” as the name of the scenario. 

Right-click the Age Analysis scenario, and select Make Current.  The red check should now be on the Age 

Analysis scenario.  Double-click on the Age Analysis scenario and select the Age Analysis Calculation Options 

in the Steady State/EPS Solver Calculation Options field.   

From the Scenarios dialog, click the Compute button. 

Close the Calculation Summary window and Scenarios dialog to view the layout screen.  

 

Results: The oldest water in the network will be found in tank T-1.  Click on the tank then the Graphs button in the 

Home tab. Create a Line-Series Graph from the New button in the Graphs dialog.  Select the Age Analysis box in 

the Scenarios field and Age (Calculated) found under “Results (Water Quality)” in the Fields field in the Graph 

Series Options window.  You should also unclick any other selected lines in the Fields field.  Close the options 

window.  The resulting graph is shown in Figure 6-3. 

 

                     Figure 6-3: Age of water in Tank T-1 

Note that the water distribution network reaches dynamic equilibrium after two days of the simulation. After 48 hrs, 

the maximum age at T-1 is approximately 21.5 hours, and the minimum age is approximately 10.5 hours. 
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To view the variation of water age in the network, click on the tank, J-2, J-3, J-7, and J-9 while holding the shift on 

the keyboard to select each object.  Then click the Graphs button on the Home tab. Create a Line-Series Graph from 

the New button in the Graphs dialog.  Select the Age Analysis box in the Scenarios field and Calculated Age, both 

under Tank and Junction in the Fields field in the Graph Series Options window.  You should also unclick any other 

selected lines in the Fields field.  Close the options window to look at the graph.  Notice that the water age at the 

junctions is much less (2 to 4 hours) than the water in the tank while the pump is on and feeding fresh water into the 

system.  Then the water age at the junctions greatly increases when the system is fed by the tank water after the pump 

turns off.  

 

Water Quality Analysis 

In order to analyze the behavior of chlorine in the network, the properties of chlorine must be defined in the 

engineering library. 

From the Components tab, select Engineering Libraries.  Expand Constituent Libraries, then right-click on 

ConstituentLibrary.xlm and select Save As.  Type “Chlorine” then click Save. Select No if ask to unregister 

ConstituentLibrary.xlm. Rename “Constituent” under the new Chlorine.xlm line by right-clicking and renaming 

it “Chlorine”. 

Click Chlorine under the Chlorine.xlm library to open the properties window.  Enter a Diffusivity value of 1.122e-

010 m2/s.  Enter the Bulk Reaction Order as 1 and the Bulk Reaction Rate as –0.5 (mg/l)1-n/day.  Because n 

=1, the units of the rate constant are day-1.  Close the Engineering Libraries. 

Click Options from the Analysis or Home tab to open the Calculation Options window.  Duplicate by highlighting 

the Age Analysis Calculations Options line then clicking the Duplicate button  and a copy of Age Analysis 

Calculation Options will be created.  With the copy highlighted, click Rename  and change the copy’s 

name to “Chlorine Analysis Calculation Options”. Double-click the chlorine calculation options you just created 

and select Constituent in the Calculation Type field. The Duration is 168 hours (7 days), and the Hydraulic 

Time Step is 1.00 hr.  Close the Calculation Options dialog.  

The analysis of the chlorine in the water within the network may be performed by defining and running a constituent 

analysis scenario. From the Analysis or Home tab, select Scenarios. 

Create a new Base Scenario by clicking the New button.  Enter “Chlorine Analysis” as the name of the scenario. 

Right-click the Chlorine Analysis scenario, and select Make Current.  The red check should now be on the 

Chlorine Analysis scenario.  Double-click on the Chlorine Analysis scenario and select the Chlorine Analysis 

Calculation Options in the Steady State/EPS Solver Calculation Options field.  Close the Scenarios window. 

Click Alternatives found under the Home or Analysis tab.  Expand on Constituent; then double-click on the Base 

Constituent alternative to open the Constituents dialog.  On the Constituent System Data tab click the ellipse 

button .  Click the Synchronization Options button  and select Import from Library.  Check the box 

for Chlorine from the Constituent Libraries list then click Select.  The Chlorine properties should be added to 

the dialog.  Close the Constituents dialog.  Select Chlorine in the Constituent field on the Constituents: Base 

Constituents Alternative window.  Close the Constituent Alternative window. 

Double-click the reservoir to define the loading of chlorine.  Select True in the Is Constituent Source? field. The 

Constituent Source Type is Concentration and the baseline concentration is 1.0 mg/L.  The constituent source 

pattern is fixed. 

The bulk reaction rate in the pipes can be adjusted using the Tables tool.  Click the Flex Table button, then select 

Pipe Table.  Add columns for the Bulk Reaction Rate (Local) and Specify Local Bulk Reaction Rate? to the 

table by clicking the Edit button  in the toolbar at the top of the table.  You can also move columns in the 

table using the double arrow icons  and .  

You can input bulk reaction rates for individual pipelines by placing a check mark in the Specify Local Bulk 

Reaction Rate? column for each pipe you want to adjust, and then entering a reaction value for the pipe in the 
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Bulk Reaction Rate (Local) column.  However, in this case the global bulk reaction rate of –0.5 (mg/l)1-n/day 

is acceptable for all system pipes, so the default values do not need to be adjusted.  Close the Pipe Table. 

Double-click the tank. Set the initial chlorine concentration to 0.000 mg/l, select True in the Specify Local Bulk 

Rate? field, then enter the bulk reaction rate of –0.5 /day.  Close the tank T-1 dialog. 

From the Analysis or Home tab, select Scenarios.  Make sure Chlorine Analysis is the current scenario then run 

the scenario by clicking the Compute button . 

Open the EPS results Time Browser from the Analysis tab by clicking the  icon.  To create a contour 

map of the chlorine concentration, click the Contours button  found on the Analysis tab.  After clicking the 

New button, the contour Field should be Concentration (Calculated); select All Elements; set the Minimum 

to 0.0, Maximum to 1.0, Increment to 0.025, and Index to 0.1 mg/L.  Click the Apply button to add the contours 

to the system layout.  Close the Contour definition dialogs. 

Click the Play button  on the Time Browser toolbar.  The chlorine concentrations for each time step can be 

viewed through time as shown in Figure 6-4. 

Save your simulation as “Tutorial 2” since this network will be used in the following tutorials. 

 

 

 

 

         Figure 6-4: Contours of Chlorine Concentration at 42 Hours 

 

Results: To view the variation of the chlorine concentration in the network, click on the tank, J-2, J-3, J-7, and J-9 

while holding the shift on the keyboard to select each object.  Then click the Graphs button in the Home tab. Create 

a Line-Series Graph from the New button in the Graphs dialog.  Select the Chlorine Analysis box in the Scenarios 

field, and Concentration (Calculated) found under “Results (Water Quality)” for both the Tank and Junction in the 

Fields field in the Graph Series Options window.  You should also unclick any other selected lines in the Fields 

field. Close the options window to look at the graph which should like Figure 6-5.  The lowest chlorine 

concentration is found in tank T-1.  Junctions J-2 and J-3 each have similar chlorine concentration values.  In 

addition, the water distribution network reaches dynamic equilibrium during the second day of the simulation. 
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During the last 24 hours of the simulation (hours 144 through 168) when dynamic equilibrium has been achieved, 

the maximum chlorine concentration at tank T-1 is 0.822 mg/l, and the minimum concentration is 0.657 mg/l. 

 

 

Figure 6-12: Chlorine Concentration in Tank T-1 and selection junctions 

 

To compare water age against chlorine concentration at a selected junction, open the graph that plotted the Calculated 

Age for the tank and junctions.  The graphs of age versus time and chlorine concentration should now be open on the 

desktop. Move the graphs so that both are visible and the axes are aligned. Comparison of the two graphs suggests an 

inverse correlation between age and chlorine concentration. 

 

Answers 

The oldest water is found in the storage tank. It is far from the source, and incoming water is mixed with the 

tank’s contents. In the distribution system, the oldest water is found at J-2. The newest water is found at J-7 

when pump PMP-1 is running. 

The lowest chlorine concentration is in Tank T-1 when it is nearly empty. In the distribution system, the lowest 

chlorine concentration is found at J-2 when T-1 is emptying. The highest concentration is at J-7 when pump 

PMP-1 is running. 

These results are consistent with the fact that chlorine concentration declines over time. For example, during the 

third day of operation, the minimum chlorine concentration at Junction J-2 is coincident with the maximum 

age, and the maximum chlorine concentration is coincident with the minimum age. 

Inspection of the graph of chlorine concentration in tank T-1 suggests that the system stabilizes into a daily 

pattern on the second day. However, if the initial tank level or the demands are changed, stabilization may 

take longer. It appears that the seven-day simulation period is adequate for this network. 
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Tutorial 3 – Pumping Costs 
 

Problem Statement 

Calculate the daily electrical costs for the network in Tutorial 2 using the following data: 

Energy price $0.10/kWh 

Motor efficiency 90% 

  50% at 2,000 L/min 

Pump efficiency 60% at 2,500 L/min 

  55% at 3,000 L/min 

 

Solution 

Open Tutorial 2 after it is completed. 

The first step is to add the pump and motor efficiency data to PMP-1. Open the Pump Definitions  found under 

the Components tab.  You can also double-click PMP-1 in the layout view to open the pump characteristics 

window. In the Pump Definition field, select Edit Pump Definitions.  The pump definition dialog appears. 

On the Efficiency tab, select the Multiple Efficiency Points option for the pump efficiency. In the Efficiency 

Points table, add the efficiency data from the problem statement. 

In the Motor section, enter 90% for the motor efficiency. 

Close the Pump Definition tool, and the pump dialog if it is open. 

The Energy Cost tool is used to calculate energy costs. From the Analysis tab, click the Energy Costs button   

on the toolbar and select Scenario Energy Cost. 

Click the Energy Pricing button  to open the Energy Pricing dialog. 

Create a New label “Energy Pricing-1” to enter the electricity cost.  Select Constant from the Tariff Type 

drawdown list. For the Energy Price enter $0.10/kWh.  Close the Energy Pricing dialog to return to the Energy 

Costs window. 

Set the scenario to Chlorine Analysis, select “Energy Pricing-1” in the Energy Pricing field located on the 

“Pumps” tab, and then click the Compute button . 

 

Answer 

On the left panel of the Energy Cost window, highlight the Chlorine Analysis line. On the right panel, select the 

Summary tab. For a detailed summary of the computed cost with time along with the detailed pump performance 

values, you can select PMP-1 in the left panel then select the Results tab on the right panel. For the seven-day 

simulation, the following data were calculated: 

 

Pump energy used 4,028 kWh 

Volume pumped 21,210 m3 

Pump cost $402.80  

Daily cost $58.60 
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Tutorial 4 – Pipe Sizing using Darwin Designer 

 

Problem Statement 

Prepare a minimal cost estimate for pipe materials and installation portion of the project in Tutorial 2. The system 

pipes should be sized using a demand multiplier of 3.4 (peak flow factor) with a calculated pressure for each junction 

between 170 and 550 kPa.  In addition, the system should supply to an industry located at junction 9 an additional 

1,500 l/min with a minimum pressure of 275 kPa.   Use the following cost data: 

 

Pipe Material and Cost 

Material Diameter (mm) Cost ($/m) 

Ductile Iron 75 40.32 

Ductile Iron 150 56.64 

Ductile Iron 200 79.36 

Ductile Iron 250 114.72 

Ductile Iron 300 156.16 

Ductile Iron 350 201.92 

 

Do not consider the cost of the reservoir, tank, pump, or pipes P-12 and P-13. 

Solution 

Open Tutorial 2 after it is completed. 

Click Options from the Home or Analysis tab to open the Calculation Options window.  Create a new Calculation 

Option by clicking the New button and enter “Designer Calculation Options” as the name. Double-click the 

calculation option you just created.  The Time Analysis Type should be set to Steady State.  

From the Home or Analysis tab, select Scenarios.  Create a new Base Scenario by clicking the New button.  Enter 

“Designer Analysis” as the name of the scenario.  

Right-click the Designer Analysis scenario, and select Make Current.  The red check should now be on the 

Designer Analysis scenario.  Double-click on the Designer Analysis scenario and select the Designer Calculation 

Options in the Steady State/EPS Solver Calculation Options field.   

From the Scenarios dialog, click the Compute button. 

Click the Darwin button  found on the Analysis tab and select Darwin Designer to create a scenario to 

determine the minimum design cost.  Click the New button and select New Designer Study.  Check to make 

sure the Representable Scenario is Designer Analysis. 

Enter design criteria on the Design Events tab in the dialog by clicking the New button.  The top window is used 

to enter general design criteria; the bottom window is for entering specific design criteria for individual or groups 

of elements (i.e. pipe, junction, tank, etc.).  It is typical that pipe networks are designed for high flow conditions.  

Scroll across to set the Demand Multiplier to 3.4.  Criteria are set to maintain a working network to avoid low 

flow or pressure conditions.  Set the Minimum Pressure (Default) to 170 kPa, and the Maximum Pressure 

(Default) to 550 kPa.  The default values for flow velocity criteria (0 to 2.44 m/s) are acceptable and do not need 

to be adjusted. 

Enter the design criteria for the industry at junction J-9 using the bottom window.  In the Demand Adjustment 

tab, use the Select from Drawing button  to select junction J-9 from the drawing.  Click on J-9 and then 

click the green check-mark Done button  in the Select dialog.  Enter 1,500 l/min into the Additional Demand 

cell on the Demand Adjustments tab.  Select the Pressure Constraints tab and again select junction J-9 from 
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the drawing.  Place a check-mark in the box in the Override Defaults? cell, and then enter 275 kPa and 550 kPa 

for the minimum and maximum pressures, respectively. 

The next step is to define the pipes to be sized by Darwin Designer.  Pipes with similar properties can be grouped 

together and will be designed the same, or the software can analyze each pipe separately.  In this case, each pipe 

will be analyzed separately.  From the problem statement, all pipes will be considered except P-12 and P-13, 

which are the pipes at the reservoir and pump.  On the Design Groups tab, click the Select Elements for Design 

Group button  to select all the pipes.  A table with all of the pipes should be displayed.  If not, highlight 

“<All Available>” in the Selection Set window, and then click OK.  Delete pipes P-12 and P-13 from the table 

to remove them from the analysis. 

The pipe material, properties, and costs to be used in this design scenario are entered in the Cost/Properties tab.  

Open the new pipe table by highlighting New Pipe in the window, then selecting Design Option Groups under 

the New button.  Rename “New Pipe-1” to “New Ductile Iron Pipe”.  Enter the pipe type, diameter, and cost per 

linear meter from the table in the problem statement.  The Hazen-Williams C is 130 for ductile iron pipe.  If it is 

necessary to change the units for pipe costs, right-click the column heading Unit Cost, and then select Units and 

Formatting.  In the Unit field, select $/m, and then click OK. 

The objective of this scenario is to size the pipes to deliver the required flow while maintaining reasonable pressures 

throughout the network at the minimum design cost.  On the Design Type tab, select the Minimize Cost criteria 

in the Objective Type date field. 

After the design criteria is entered, start the simulation by highlighting New Design Study-1 in the left panel of the 

window then click New to select New Optimized Design Run.  Several different types of design runs may be 

performed by selecting different design events or design groups to be compared.  Since there is only one design 

run in this demonstration, comparisons of different potential design solutions will not be possible.  In many 

cases, different solutions need to be compared to determine the optimum solution for the design situation.  The 

left panel of the Darwin Designer window helps to organize different solutions. 

On the Design Events tab, select the design criteria to be evaluated.  New Design Event-1 should be checked as 

Active.   

On the Design Groups tab, select the ductile iron properties and cost that were entered.  The data is entered in the 

Cost/properties column.  Since all designed pipe will come from the same ductile iron table, enter the data using 

global edit.  Right-click the Cost/properties field and select Global Edit.  Select “New Ductile Iron Pipe” in 

the Value window.  Click OK and all of the Cost/properties fields should fill in.   

The Options tab allows Darwin Designer parameters to be adjusted.  In this case the default values are acceptable 

and will be used. 

To start the run, click the Compute button  in the Darwin Designer toolbar.  When the run is completed, Close 

the Designing… window.  The top three solutions will be listed under the “New Optimized Design Run” in the 

left panel of the Darwin Designer window.   

 

Answer 

A summary table of the three solutions is shown by clicking the Solutions folder and beneath this are tables that 

have the determined pipe diameters for each solution.   In this example, the minimal pipe cost is $209,949.  A 

summary of each solution cost and the design pipe diameters for Solution 1 are shown in the tables below.  Pipe 

diameters range from 75 to 250 mm and the cost for each pipe is determined based on the entered pipe length.  

Open Solution 1 and select the Simulated Results tab.  The calculated pressure at the industry (junction J-9) is 

284 kPa, which is within the required range.   

It also should be noted that there are a number of 75 mm (3-inch) pipes in this solution, and the pipe connecting the 

network to the tank (P-14) is only a 200 mm (8-inch diameter) pipe.  If this solution was evaluated for fire flow 

conditions, it is likely that these pipes would not deliver the required fire flow.  Further simulations should be 

conducted on this solution to ensure that this design can deliver the required flow during a fire event.  

 



61 

 

 

      
Darwin Designer Solutions 

 
Pipe Diameters and Costs for Solution 1 

Solution Total Cost ($) 
 

Pipe Diameter (mm) Cost ($) 

Solution 1 209,949 
 

P-1 75 12,096 

Solution 2 209,984 
 

P-2 75 12,298 

Solution 3 210,777 
 

P-3 250 25,812 

   
P-4 75 12,136 

   
P-5 75 9,072 

   
P-6 200 23,887 

   
P-7 75 9,072 

   
P-8 75 12,136 

   
P-9 150 11,328 

   
P-10 200 23,887 

   
P-11 250 34,416 

   
P-14 200 23,808 

   Total Cost: 209,949 

      
 

 

 

 

Tutorial 5 – Model Calibration using Darwin Calibrator 

WaterGEMS has the ability to use measured field data to calibrate the model.  In many cases, data that are entered 

into the model are an approximation or guess.  When the model results do not match field data, parameters in the 

model need to be adjusted.  Also, the Darwin Calibrator with field data can be used to locate potential differences 

between the real network and the model which could be caused by problems in the system (blockages, closed valves, 

etc.).   

Problem Statement 

Adjust the Hazen-Williams C factor (roughness factor) for pipes P-1, P-2, P-3, P-7 and P-8 from the pipe network 

used in Tutorial 2.  The tank level was at 3.93 meters during field measurements, the pump was off, and a hydrant 

with a measured flow of 3,400 l/min at junction J-7 was opened to increase the head loss in the pipe network.  The 

measured field data is shown in the table below.  

 

Field Data with Hydrant open 

Junction  Pressure (kPa) 

J-1 263.5 

J-2 327.0 

J-6 406.5 

J-7 296.0 

 

Solution 
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Open Tutorial 2 after it is completed. 

Click Options from the Home or Analysis tab to open the Calculation Options window.  Create a new Calculation 

Option by clicking the New button and enter “Calibrator Calculation Options” as the name. Double-click the 

calculation option you just created.  The Time Analysis Type should be set to Steady State.  

From the Home or Analysis tab, select Scenarios.  Create a new Base Scenario by clicking the New button.  Enter 

“Calibrator Analysis” as the name of the scenario.  

Right-click the Calibrator Analysis scenario, and select Make Current.  The red check should now be on the 

Calibrator Analysis scenario.  Double-click on the Calibrator Analysis scenario and select the Calibrator 

Calculation Options in the Steady State/EPS Solver Calculation Options field.   

From the Scenarios dialog, click the Compute button. 

Click the Darwin button  found on the Analysis tab and select Darwin Calibrator to create a scenario to 

conduct a calibration study to determine the pipe roughness factors.  Click the New button and select New 

Calibration Study.  Check to make sure the Representable Scenario is Calibrator Analysis. 

The top window is used to enter general criteria; the bottom window is for entering specific criteria for individual 

or groups of elements (i.e. pipe, junction, tank, etc.).  Enter the field data in the Field Data Snapshots tab.  Click 

the New button to on the top panel enter new data.  

Enter the measured pressures on the Observed Target tab of the lower panel.  Select the junctions from the drawing 

by clicking the select  button  then clicking junctions J-1, J-2, J-6, and J-7 from the drawing.  Click the green 

check-mark Done button  in the Select dialog.  Select Pressure (kPa) for each junction in the Attribute field.  

Enter the measured pressure for each junction in the Value field. 

Enter the tank level in the Boundary Overrides tab.  Select the tank from the drawing by clicking the select button 

 then clicking the tank.  Click the green check-mark Done button  in the Select dialog.  Select Tank 

Level (m) in the Attribute field, and enter 3.93 meters in the Value field. 

To make sure the pump is off, in the Boundary Overrides tab select the pump by clicking the select button , 

then clicking the pump.  Click the green check-mark Done button  in the Select dialog.  Select Pump Status 

in the Attribute field, then select Off in the Value field. 

Enter the additional demand at junction 7 in the Demand Adjustments tab.  Select this junction from the drawing 

by clicking the select button , then clicking J-7.  Click the green check-mark Done button  in the Select 

dialog.  Enter 3,400 l/min in the Value field. 

Select the pipes where the roughness values are to be determined in the Roughness Groups tab.  Pipes can be 

evaluated separately, or pipes with similar roughness characteristics can be grouped together.  In this case, 

Darwin Calibrator will determine the pipe roughness values for P-1, P-2, and P-8 separately, and pipes P-3 and 

P-7 will be grouped together.  Click the New button, then the ellipse button  in the Elements IDs field.  Click 

the select button , and then select pipe P-1 from the drawing.  Click the green check-mark Done button  

in the Select dialog.  Click OK to enter this pipe into the table as New Roughness Group - 1.  Repeat these 

steps to add pipes P-2 and P-8 to the table as separate roughness groups.  When completed, there should be three 

defined roughness groups in the table on the Roughness Groups tab. 

Add the grouped pipes by clicking the New button, then the ellipse button  in the Elements IDs field.  Click the 

select button , then select pipes P-3 and P-7 from the drawing.  Click the green check-mark Done       button 

 in the Select dialog.  Click OK to enter these pipes into the table as a group.  There should now be four 

roughness groups in the table on the Roughness Groups tab. 

Darwin calibration method settings are found on the Calibration Criteria tab.  In this case, the default settings are 

acceptable and will be used for the calibration analysis. 

To use this data to determine the pipe roughness values, create a new run by clicking the New button on the left 

panel of the Darwin Calibrator window and then select New Optimized Run. 
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The pipe roughness values are assumed to have a range between 5 and 140 for each pipe.  This is wide range and 

any chokes (blockages, partially closed valves, etc.) in a pipe could greatly reduce the pipe roughness value.  It 

is not expected that a roughness value above 140 would be observed for ductile iron pipe.  On the Roughness 

tab in the Operation field, Set should be selected; the indicated minimum (5) and maximum (140) roughness 

values should be entered in the Minimum Value and Maximum Value fields.  Enter the increment to be used 

to analyze roughness values by entering 5 into the Increment field. 

For this simulation, the top 5 solutions will be displayed.  Click the Options tab and enter 5 into the Solutions to 

Keep field. 

To start the run, click the Compute button  in the Darwin Calibrator toolbar.  When the run is completed, close 

the Calibration… window.  The top five solutions will be listed under the “New Optimized Run” in the left 

panel of the Darwin Calibrator window. 

 

Answer 

The fitness values of the five solutions are shown by clicking the Solutions folder.   In this example, the fitness values 

ranged from 0.288 to 0.343 where a lower fitness value indicates a “better” solution.  A summary of each solution 

with the determined roughness values are shown in the table below.  To view the determined roughness values for the 

“best” solution, click the Solution 1 summary and highlight Roughness in the Adjustments Results window under 

the Solutions tab.   To view the observed and simulated Hydraulic Grade Line (HGL), click the Simulated Results 

tab. 

 

Darwin Calibrator Solutions 

  Roughness Value 

Solution P-1 P-2 P-8 P-3 and P-7 

Solution 1 20 50 30 135 

Solution 2 20 50 45 140 

Solution 3 25 65 55 130 

Solution 4 20 50 85 140 

Solution 5 20 50 130 140 

 

 

These results indicate that the grouped pipes P-3 and P-7 have roughness values that are about what would be expected 

for the installed ductile iron pipe.  However, the results for pipe P-1, P-2, and P-8 show that the roughness value is 

much lower.  This could indicate a partially closed valve, the pipe is blocked, or that the pipe diameter may be smaller 

than expected.  In this case, pipe P-1 should be investigated to determine the cause of this low roughness value.  If 

there is a problem and that problem was fixed, new field measurements should be taken. 

These roughness values can be entered into the model and further simulations can be conducted for different 

conditions.  With enough field data for different hydraulic conditions, a model that closely simulates the actual system 

can be created.  Keep in mind that many times the person doing the modeling must decide what values to put into the 

model.  The software can only calculate values based on what is entered.  The person doing the modeling must judge 

how accurate the model is and whether the model can be used to make decisions. 

 

 

  


